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WARRANTY

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the media will be free
from defects in materials and workmanship for a period of three (3) months from the date of shipment. If a medium or encoding proves
defective during the warranty period, Tektronix will provide a replacement in exchange for the defective medium. Except as to the media
on which this software product is furnished, this software product is provided “as is” without warranty of any kind, either express or
implied. Tektronix does not warrant that the functions contained in this software product will meet Customer’s requirements or that the
operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period. If
Tektronix is unable to provide a replacement that is free from defects in materials and workmanship within a reasonable time thereafter,
Customer may terminate the license for this software product and return this software product and any associated materials for credit or
refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND
ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S PAYMENT IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS
WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF
WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



Table of Contents

Table of Contents

General Safely SUMMaArY . . .. ... i
PrEaCE . . oo i
Ky FealUNES . . ..o i
DOCUMENEAION . . . . oo i
SOftWare Upgrades . . . . ..o oottt e iv
Contacting TeKIrONIX . . . . . oo iv
Install the SOftWare . ... ... 1
Before Installation . . . ... ... 1
INStallation . . . . ..o 1
Connect to the OSCIllOSCOPE . . . . .o oot e e 1
Start the Software . . . ... ..o 2
Closethe SOWAre . ... ..o e 4

Get Acquainted with the Software . . ... ... .. 5
Use the INterface .. ... ..o 5
Virtual Keyboard . . .. ... 5

Virtual Keypad . . . ..o e 6

General Purpose Knob . . . ... oo 7

Sl PO OrBNCES . . o oo 7
Hide and Returnthe TDSHT3 Software . ... ... ...t e i 8

Use the TDSHT3 SOftWare . . .. ...t e et e e e e e e 9
Tests: Process FIOW . . ... 9
SeleCt @ TESt .. 9
Configure the Test Parameters . . . . .. ..ottt e e 10
Connect and Configure the EQUIDMENE . . . . ... .. 10
View the Waveform . . ... 1
RUNthe Test . . o 1
Interpret the Test ResUlt . . ... ... o 12
Generate and Print @ Report . . .. ... o 14
SUMMIATY ..ot 14

Detall . .. 15
Application EXamples . . . . . oo 18
Source: Select All (Clock-Data Tests) . . . ... oot 18
Source: Inter-Pair Skew (Data-Data Tests) ... ........oourii i 21
Sink: Min-Diff Sensitivity Test . . . . ... ..o 24
Sink: Jitter Tolerance Test . . . . ..o 26
Cable: Eye Diagram Test . . . ...ttt 29
Enable Remote Control of Test Equipment . .. ... ... 32
Install NI-488.2 for WINdOWS . . . . ...ttt e e e e e e 32

Connect the EQUIPMENT . . . ... oo 33

Verify the Equipment ConNeCtioNS . . . . . . ...t 33

Setthe GPIB BUS TIMING . . . ..ottt ettt et ettt e e e e e e e et e e 34
Configure the GPIB AdAress . . . . . . oottt e e e e e 34

X o e 36

TDSHT3 HDMI Compliance Test Software Quick Start User Manual i



General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.
While using this product, you may need to access other parts of the system. Read the General Safety Summary in other
system manuals for warnings and cautions related to operating the system.
To Avoid Fire or Personal Injury

Connect and Disconnect Properly. Connect the probe output to the measurement instrument before connecting the
probe to the circuit under test. Disconnect the probe input and the probe ground from the circuit under test before
disconnecting the probe from the measurement instrument.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.
Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this product, have it inspected by
qualified service personnel.

Do Not Operate in Wet/Damp Conditions.
Do Note Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

i TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Preface

Preface

The TDSHT3 HDMI Compliance Test Software is a High Definition Multimedia Interface (HDMI) Compliance Test Solution,
which runs on a Tektronix oscilloscope. This software helps you perform HDMI physical layer validation and compliance
testing.

Key Features

Conformance to HDMI 1.0 standards and test specifications (CTS version 1.0) ensures reliable results
Complete validation to standards with wide range of tests for source, sink, and cable devices
Accurate source tests using precise measurement techniques

Dependable sink tests with closed-loop measurements that eliminate nonlinearities in test setup
Automated sink and cable tests with remote control of signal sources

Automatic mask fit, measurements, and pass or fail notification

In-depth analysis with statistical analysis and mask margins

One-button selection of multiple tests

One-button csv-format summary and reports

Complete compliance solution with an elaborate test fixture, signal sources, and TDR

Documentation

This manual describes the installation and basic operation of the TSDHT3 software. For more detailed information, see the
online help. The following information is available for this product:

TDSHT3 Online Help

Start > Programs > TekApplications > TDSHT3 > Help

TDSHT3 Online Help (PDF)

TDSHT3 Quick Start User Manual, English (PDF) + @

TDSHT3 Quick Start User Manual, Japanese (PDF)
TDSHT3 Quick Reference Card, Source Test (PDF)

, . —
TDSHT3 Quick Reference Card, Sink Test (PDF) =

(Documents folder)

B

C:\TekApplications\TDSHT3\Manuals Www.Tektronix.com

Installation Manual: Optional Application Software on
Windows-Based Oscilloscopes
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Preface

Software Upgrades

Periodic software upgrades may become available. Note that the software is only operational if you have a valid option key

for the specific oscilloscope model and serial number.

To check for upgrades:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Select Software and Drivers.

3. Enter the product name (TDSHT3).

Contact Tektronix
Phone 1-800-833-9200 1
Address Tektronix, Inc.
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA
Web site www.tektronix.com
Sales support 1-800-833-9200, select option 11
Service support 1-800-833-9200, select option 2 1

Technical support

Email: techsupport@tektronix.com

1-800-833-9200, select option 3 1
6:00 a.m. - 5:00 p.m. Pacific time

1 This phone number is toll free in North America. After office hours, please leave a voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the Tektronix Web site for a list of offices.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Install the Software

Install the Software
The TDSHT3 software must be installed on a Tektronix oscilloscope. The following models are supported:
= TDS7704B
= TDS7404/B
= CSA7404/B

= TDS7254/B

Before Installation

m  TekVisa must be installed on the oscilloscope. If you do not have TekVisa, you can download it from the Tektronix Web
site, in the same location as for Software Upgrades (see page iv).

= Please read the Readme.txt file on the product software CD before you install the software.

Installation

1. Close all applications.
2. Insert the product software CD into the CD drive of the oscilloscope.

3. The installation wizard will guide you through the installation. If this is a version upgrade, the existing software will be
automatically removed before the new version is installed.

4. The software files will be installed at C: \Program Files\TekApplications\TDSHT3.

Connect to the Oscilloscope

The various tests require specific equipment setups and specific test adapters. Click More within the connect pane to see
how to connect the device under test and test equipment to your oscilloscope. The following test adapters are required:

= Tektronix HDMI TPA-P-DI (for Differential Source tests)

Tektronix HDMI TPA-P-SE (for Single-Ended Source tests)

Tektronix HDMI TPA-P-TDR (for TDR tests)

Tektronix HDMI TPA-R-DI (for Cable tests and Sink tests)

Tektronix HDMI TPA-R-SE (for Cable tests and Sink tests)

Tektronix HDMI TPA-R-TDR (for TDR tests and Sink tests)

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 1



Install the Software

Start the Software

To start supported 7000-series oscillo-
scopes:

1. From the oscilloscope menu, select
File > Run application > HDMI Com-
pliance Test Software.

2. The oscilloscope display resizes to fit
in the upper part of the screen.

3. The software displays in the lower part
of the screen.

4. Proceed to step 5.

To start supported B-series oscilloscopes:

1. Select App > HDMI Compliance Test
Software.

File Edit  werticll  Hotigfdcg  Trig  Displg ors  Measwre Masks Math  Utlities  Help

Reference iWaveforms 3
Instrument Setup...
Recall Defaul: Setup

U3SBZ.0 Test Package
Page Setup...

Print Preview
Print. . CtrHP

Export Setup...
Select for Export 3
Expart...

1 Recent Setup File L

Minimize Chrl+1

File — Edit  Wertical

! : plitude +
I
onnect o
e i Lo Amplitude - Sumnary

Source -» Eye Diagram Clock-» Ch1; Data-> Ch2; Res Length -> 8M; CRU -> PLL

Shutdown. .,

Hotizfacqg  Trig  Display  Cursors  Measure  Masks Math  Utliies  Help

Position

Factor

13

TDSHT3

Z - =
i [ Cable Run
Clock-Data Tests Data-Data Tests Single-Ended Tests Test

Eye Diagram . .Inter—F‘aH .Intra-F‘a ey
Result

m JDHE”

File Edit Verical HorizAcq Trig Display Cursors Measure Masks Math | App Ulilities Help Buttons
Tek Run  Sample

Restore Application)
USEZ.0 Test Package
HDMI Compliance Test Software
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Install the Software

2. The osci"oscope d|sp|ay resizes to f|t File Edit Verical HorizZAcq Trig Display Cursors Measure Masks Math App Utiiies Help Butions

Tek Stopped Single Seq 1 Acgs 21 Jun 04 05:00:01

in the upper part of the screen. Y

o B o R e AR
i) Pty et Rnest

3. The software displays in the lower part N | ,I g ] /
of the screen. e s ST

4. Proceed to step 5.

Run
Test
Result

T Summany
Select Al Dzl

Saurce -> Eye Diagram Clock-> Ch1; Data -> Ch2; Rec Length -> 32M; CRU -> PLL

NOTE. To ensure accurate results, calibrate the probes and the oscilloscope before you run tests.

5_ CI|Ck Utilities > Instrument calibra- Fle  Edit  Vertical  Haorizfdcq  Trig  Display  Cursors  Measure  Masks  Math | Utiities  Help
tion to begin calibrating the oscillo- e B Tchecuc B

Sek Time & Date...
GPIE Configuration. ..
LAR Server Status...

6. Click Calibrate. By
Instrument Diagnosti .

Deassign Multipurpose Knobs

scope for signal path compensation.

User Preferences...

Option Installation...

Calibration Instructions
Status
Wt m-Up

Galibrate :
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Install the Software

7. Select Vertical > Probe Cal to begin
calibrating the probes.

8. Connect the probe calibration signal to
the probe.

9. Click Calibrate Probe.

Close the Software

1. Select File > Exit.
2. You can also click the exit icon.

Using other methods to exit the software
will result in abnormal termination.

3. When you exit the software, you can
restore the oscilloscope to the settings
that were in place before the TDSHT3
software changed them.

File  Edit

Wertical Horiztacq Trig Display CUFsors Measure  Masks  Math Utilities Help

Vertical Setup... 21.Jun 04 17 o

Zoom Cantrols...

Display OnfoFf. .. Position

PositionfScale. ..
Label...

Offset...
Termination. ..
Zoupling. ..
Bandwidth. ..

Deskew,
Attenuation...

Zoom Setup...
Zoom Graticule Size ¥

Sle  Edit  Wertical Hotizfacqg  Trig  Display  Cursors  Measure  Masks Math  Utliies  Help

b\

\“Hﬂ'nmw‘

B Pttty iy #

File Tests Results Utilities Help

Recall Default
Recall..
Save..

Recall Recent »

Freferences
Minimize

i 3w eform

21 .Jun 04
1.Jun 04 App

Position
5

Factor

! ‘ | ‘ 13

l“hﬂw\nwm [ el

ety \.-M-#M\] wmm\-\wm]
|

4
I
|

| Prohe Status
Initialized

Clear Probecal

§ 1 1 |--| calibrate Probe
LT ol Yot

thz  z0 2 IT 10

TDSHT3

i Cable Run
Clock-Data Tests Test

Result

3

Detail

Source -* Eye Diagram Clogk-* Chi: Data -* Ch2: Rec Length -* 1M; CRU -= PLL

O—=EE &N

Do you want to restore the oscilloscope settings to
their state prior to starting this application?
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Get Acquainted with the Software

Get Acquainted with the Software

Use the Interface

Use a keyboard, mouse, or touchscreen to make selections in the TDSHT3 software.

Use menus, check boxes, and on-screen buttons to control the software functions. Use Microsoft Windows techniques to
navigate menus and select or clear check boxes.

Device under test (DUT) type Client pane Execution pane

Menu bar Tle Tests Results Utlites Help TDSHT3 E] x||

Differential Tests Single-Ended Tests

-h_ﬂin-[:lif‘l' itivity .._Iiﬂer Taolerance Ir.tra-F'air ={H
Configurs

Selection pane Report—,

g
W awetarm

Status bar Tk -= Intra-P air Skew Clock -> Chi; Thit: Reeale; Avgs-» 100
Virtual Keyboard
1. Click a keyboard icon. osars | @ x|

Configure - Sink

Pattern Path g?tallv
Canfi .
-or\ igure o icationd 2]
Data2

Wiem
i 3w eform

Sink -2 Min-Ditf 5ensitivity Input-= Ch1: Wiem -» 3.0

2. Clear the existing text and type the DTG Poze path
new text. Ee CiTekdpplicationsiTDSHTHF attemaATES TS5 D itfSensitivity
3. Click Enter to confirm your selection. - -

7
i } |
[T K K K

Cape Lok nn--
2 = 2
Ehift z x C W M ;

NOTE. You must click Enter on the virtual keyboard; otherwise your selections are not valid.
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Get Acquainted with the Software

Virtual Keypad
1. Click any number box. File Tests Results Ltiities o TDSHT3 my| x|
Configure - Source
H H Input HorizifAcq Reference Levels Run
2. Click the keypad icon. ot \\‘. o e o
Chl * Abs
chz ¥ Rec Length ; o Report—|
Connect M — o
Wiew CRU
Waveform Detall
Source -* Multiple Tests Clogk -+ Chi: Data -* Ch2: Rec Length -+ AM: CRU -= PLL
3. Clear existing value and enter the de- ¢ of Acgs

sired value.
4. Select a unit of measure.

5. Click Enter to confirm your selection.

NOTE. You must click Enter on the virtual keypad; otherwise your selections are not valid.
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Get Acquainted with the Software

General Purpose Knob

1. Click any number box to display the
connection to one of the general pur-
pose knobs.

2. Turn the corresponding knob on the
oscilloscope front panel to adjust the
value for the selected parameter.

3. For better resolution, press the FINE
button.

Set Preferences

1. From the TDSHT3 software menu bar,
click File > Preferences, and then se-
lect an option.

2. Click the option again to clear the

File Tests Results Utiliies Help TDSHT3 m x|

Configure - Source
Horizifcq Reference Levels
Salact ) 3 .«
#of Acgs ® Units High e
€ ” L
e (%)
Hysteresis i
Report—|
etai

Wiem
i 3w eform

Source -* Eye Diagram Closk-> Ch

[©
(e c00]g B @ B - |
J 7

File Tests Results Utilities Help

TDSHT3 || x|

Run
Differential Tests Single-Ended Tests Test

.Jiﬂar Tolerance -lntla—F‘alr Sk
Result

Recall Default % _—Select - Sink
EEETE— Cable

Recall...

Save

Recall Recent »

. Fosition Eve Maskin Center Report—|
selection. Acquisition Alert Message Summary
Lo E
Sink-= Min-Ditf Sensitivity Input-* Ch1: Wiem -= 3.00;
Option Description

Position Eye Mask in Center

Selected: Positions the mask at the center of the eye diagram.
Cleared: Positions the mask to the left of the eye diagram.

Acquisition Alert Message

Selected: An alert prompts you to specify oscilloscope settings with
which to run the test.
Cleared: TDSHTS3 software selects oscilloscope settings.

Trigger
Rise/Fall Time or Over/Undershoot
(Available for B-series oscilloscopes only)

These tests can be run with a width trigger or an edge trigger
(default). If the signal has very high intersymbol interference (ISI),
use the width trigger.
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Get Acquainted with the Software

Hide and Return the TDSHT3 Software

1. Click the hide icon to minimize the @
TDSHTS3 software and enlarge the os-
cilloscope display.

File Tests Results LUtilities Help TDSHT3 M X

Configure - Source

Horizifcq Reference Lew Run
Units Test
Ch 10k F‘»‘:rl":i._l hd
Configure Result
Rec Length [ein=s &

Chz
I M v
Connact iy
Detail

To return to the TDSHT3 software:

Source -= Multiple Tests Clock-» Ch1: Data-= Ch2: Rec Length -» 1h: CRU -* PLL: High -= 80%: Low-* 20%

2_ For 7000-ser|es OSC"IOSCOpeS’ Select Fle  Edit  Vertical  Haorizfdcq  Trig  Display  Cursors  Measure  Masks  Math  Ubliies  Help
the APP button. Naasasan —

4 W"Ww‘ | | —
\“Hﬂ'ﬂwﬁ "ﬁ-“ . . . . . |

File Edit Verical HorizAcq Trig Display Cursors Measure Masks Math | App Ulilities Help Buttons

3. For 7000/B-series oscilloscopes, select ;
T Tek Stopped Single Seq 1 Acgs | Restore Application |
App > Restore Application. 1U562.0 Test Packsge

HDMI Compliance Test Software
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Use the HDMI Software

Use the TDSHT3 Software

Tests: Process Flow

When you make a test, follow the sequence of actions indicated in steps 1 through 6. Details for each of these actions are
given on the following pages.

1. Select atest. @ @

File [ests Results Utiliies Help TDSHT3 my %
i Source [ Sil van

_Select - Source
=

Configure the test parameters.
Connect and configure the equipment.

View the waveform to verify test signal. @
Run the test. @
Interpret the test result.

Generate a report.

Data-Data Tests

N o o &~ o b

NOTE. For accurate test results, calibrate the oscilloscope and probes before you begin the tests. See page 3.

Select a Test

1. Click Select. @ @ @
2. Click the Source, Sink, or Cable tab.

File Tests Results Utiliies Hel TDSHT3 m x|

3. Move the mouse near a test name until

Run

the test ID appears. This ID corre- Selact [ =
sponds to the Test ID in the HDMI S e =

Compliance Test Specifications.

Ris:
Wiem
i 3w eform

Source -* Clock Jitter Clogk-* Ch1: Rec Length -» 1M: CRU-> PLL

4. Select the test that you want to run.

Report—|
etai

You can select multiple tests, but they
must all be of the same type.

5. To select all tests of a certain type,
click Select All.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 9



Use the HDMI Software

Configure the Test Parameters

1. Click Configure. File Tests Results Utiifies Help TDSHT3 B x|

Configure - Source
2. Use the virtual keyboard or the general o e | fetereneetents o
purpose knob on the oscilloscope front - (3 " -
. Configure Result
panel to change the values if neces- : I Ree Length Hysteresis J: Mid —
sary. T
You can also use the File menu to oot

restore factory defaults or save and
recall your own configuration settings.

Source -* Eye Diagram Clogk-* Chi: Data -* Ch2: Rec Length -* 1M; CRU -= PLL

Connect and Configure the Equipment

10

NOTE. If your test uses remote control, the setup diagram in the online help shows how to connect the test equipment by
using an E-net connection. You can either use this method or you can use the GPIB-B connection described on
pages 32 through 35 of this document. Example tests are shown in the Application Examples section, starting on page 18.

1. Click Connect. @
2 flities  Help

. Follow the on-screen instructions to File Tests Results

TDSHT3 || x|

connect and configure the device un- e, -
der test and the test equipment. fed
3. Click More to view the online help for o : e DT,

the selected test, which contains a set-
up diagram. Connect the test equip-
ment as shown in the diagram.

4. If the AWG and DTG are used for the
selected test, select Signal Sources
and configure the test equipment. For
more information, see the remote con-
trol procedure on pages 32 through 35
of this document, or refer to the online
help.

Report—|
Detail

Sink -= Jitter Tolerance Clogk-* Ch1; Data -* Ch2: Rec Length -* 1h; CRU -> PLL; Freq Pair-* D, Ck:500KHz, 10MHz
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Use the HDMI Software

View the Waveform

1. Cllck View Waveform (not appllcable Flle  Edit  Wertical  Horigfacq  Trig  Display  Cursors  Measure  Masks  Math  Utlities  Help

for all tests).

2. Verify that the waveform in the upper
part of display is similar to the wave-
form that is displayed in the TDSHT3
software.

If the displays are not similar, check

your configuration and connections. LTS
View Waveform

Select { & signal§) as shown. Click WMbre for details, _':u:‘
-
Configure | 4 i Result

Wiy
i avetorm

Source -> InterPair SkevaD D) Data A-= Ch1; Data B -» Ch2; Thit: 1.3503ns

=

Detail

Run the Test

1. Click Run Test.

File Tests Results Utiliies Help
2. The test will run, displaying a progress Result Summary: Source
indicator. St

Status :

Canfi
onfigure Current Test:

Completed : o
Summary
Detail

Connect

Wiem

i 3w eform

Al

Source -* Eye Diagram Clogk-* Chi: Data -* Ch2: Rec Length -* 1M; CRU -= PLL
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Use the HDMI Software

Interpret the Test Result

12

1. When the test completes, the Result

Summary appears. Check to see if the
device passed the test.

means Pass
El means Fail
means Error

If the device did not pass the test, use
steps 2 through 8 to solve the problem,
and then rerun the test.

. Click Result Details for a spreadsheet

with details about the test result.

. Check the Remarks column. If any er-

ror codes are present, see the online
help for error code descriptions.

File Tests Results Utilities Help

Test Name

.7.10: Data Eye Diagram: Ck, D

Wiy
Wi aveferm

Source -# Eye [riagram Clazk -> Ch1; Data -> Ch2; Rec

Result Details

Test Hame
7-10: Source Eve Biagram: CK, b

NOTE. The parameters in the Result Details dialog box may change depending on the test that you run.
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Use the HDMI Software

If you ran an eye diagram test, a plot
appears. You can do the following:

4. Save the image to
C:\TekApplications\TDSHT3\Images

(you can also change this path). sk ot
. ] M Fine
5. Zoom in and out. : : W coarsa

Resed ‘
u .
Results

Mask Test

Mask Hits 0

6. View the histogram.

7. Move the mask to see the margin of
error.

Vswing  952.00mV

Vaoltage [167mvidiv]

Thit 1.3482ns

Data Jitter 187ps

8. View statistics.

-

Hist Pk-Pk  187ps

9. Change the plot to half screen size
(WhiCh returns the Result Summary). 7 Time [ 270ps/ div]

10. A plot also appears if you ran the clock £ Clock Jitter
jitter test. In this plot, you will find the :
peak-to-peak jitter of the clock.

Results
Result
Pk-Pk 97.6ps
Vewing 932.40mV

[163mY { div]

voltage

Thit 1.3482ns

-

ITPk-Pk 124.12ps

Hist Pk-Pk  97.6ps
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Use the HDMI Software

Generate and Print a Report

You can generate and print a summary or detailed report as described here.

You can also use the Report Generator to create and print customized reports. You can save files as RTF, or in custom file
formats such as RGT, RPL, and RPT. For more information about the Report Generator, see online help.

Summary

After you have successfully run a test or tests, you can generate a report summary as a .csv file.

1. Click Summary in the execution pane.

2. A message indicates where the report
summary is saved.

3. Open the file and print the report.

14

File Tests Results Utiliies Help TDSHT3 m x|

Result Summany: Source Report Configuration

Report Summary...

.
ions! =]

Wiew
iaveform |l Enable Preview

Clogk-* Chi: Data -* Ch2: Rec Length -* 1M; CRU -= PLL

Source -» Eye Diagram
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Use the HDMI Software

Detail

After you run a test, you can generate a report that contains default information or information that you configure.

1. Click Result to begin configuring the
report (or skip to step 14 for defaults).

TDSHT3 ( 2
2. Select the input on which you con-

|
Report Configuration
ducted the test. : — e
Pair (CK, D) patay ¥ .

3. Enter the resolution at which you con-
ducted the test (such as 40 Hz, 43 Hz,
o7 HZ’ or 60 HZ) Refresh Rate G0Hz

Rezolution

4. Enter the refresh rate at which you Report File
conducted the test (such as VGA,
SVGA, XGA, or SXGA).

5. Note the location where the report will R L
be saved; you can change the location @ @

if desired.

6. Select Enable Preview to view the re-
port on screen when the report is gen-
erated.

7. Click Clear Report to clear all reports.
Reports generated between this and
the next successful test run will have
no values.

8. Click Advanced.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 15



Use the HDMI Software

16

9.

10.
11.

12.

13.

Enter the DUT ID (serial number).
Enter the DUT details (product type).

Enter the pair(s) that you are using for
single-ended and differential tests.
These entries correspond to the con-
nectors on the HDMI adapter; see the
setup diagrams.

When this check box is cleared, the

TDSHTS3 software configures the oscil-

loscope to display jpeg images in re-
ports.

If you want to change the default
image export settings, change the
settings in the oscilloscope image

export setup and check this check box.

Click OK.

Report Configuration Advanced..

Dewvice D TOSHTZ2_ 004

Device Detail=  HODMI Device
Pair {Single-Ended) _ D atan

Pair (D, D} | Datad - Data

alzettings for image export

Cancel

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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14. Click Detail in the report pane to gen-
erate the report.

= If Enable Preview is selected, the
Report Viewer utility displays the
report. Otherwise, a dialog box
displays the location where the
report was saved.

= For an eye diagram or clock jitter
test, a plot is also displayed.

= You can use the Report Viewer
Edit menu to edit the report, if
desired.

m  Use the Report Viewer File menu
to print the report or export the
report to an RTF file.

File Edit View Object Help

EH R BG4 RSBk EFLE|= 0 #|

ol x]
Test ID/Name : 7-10: Data Eye Diagram : CK, D ;I
Spec Hange : Data Jitter < 0.3*TBit;
Meas Value : 0.27022°TEit

|

Heesult : Pase

Thit : 1.0000ns
Vewing : VeD =864 48mV

B

Ready

= U R

NOTE. The report details are real time and no history is maintained. Save the report details before making another test.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Application Examples
Source: Select All (Clock-Data Tests)

This selection runs a set of tests simultaneously.

Required equipment Example

2 differential probes; Ground lead Tektronix P7330 or later; Tektronix 196-3469-00
1 DC power supply, setto 3.3V Kenwood PW18-1.8AQ

1 EDID emulator Silicon Image TE9100

1 input adapter Tektronix TPA-P-DI

Probe Calibration and Deskew fixture Tektronix 067-1478-xx

1. Click Select.

2. Click the Source tab. File “ests Results Utilies Help TDSHT3 || x|
3- CI|Ck Select A". Select — i f

Clock-Data Tests ata-Data Tests Single-Ended Tests

9 1 & ter-Pai -\nlra-F'sir Shew
Configure Result

Report—|

tise Time o e -
Wiem I
Waeform b e -

Source -* Ho Testsselected

Source -> Multiple Tests Clock-> Chi; Data-» Ch2; Rec Length->

4. Click Configure. Change these values File Tests Rp Utiliies  Help TDSHT3 B x|
if needed. (You can generally use the Q R =
default Va'UeS.) Cloek #of hegs ® i -Te'sl

chi W 10k e .
Genfigure
Data j

chz - Rec Length - Report—|

m - i
Connest Summary
Wiew e
ifaveform o

Clock-* Ch1: Data-»* Ch2: Rec Length -* 1M: CRU -> PLL: High -» 80%: Low-> 20%

Source - Multiple Tests

5. Click Connect. File Tests Results Utiities Help TDSHT3 m| x|

Connect

Seleot Follow these instructions 1o set up the connections.
&

setup Dedeu

Report—|

tup the DUT.

Summary

Detail

18 TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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6. Connect and configure the equipment: Digital Oscilloscope

= Connect the test equipment as
shown in the setup diagram.

= Configure the source DUT to
output the first supported video

EDID Emulator

format.

= Configure the EDID Emulator for
the required resolution (refer to the

EDID Emulator user manual).

7. Click View Waveform. Fle  Edt vertca

Verify that the oscilloscope displays a
similar waveform to the one displayed
by the TDSHT3 software. If the
displays are not similar, check your
configuration and connections.

Hotizfacqg  Trig  Display  Cursors  Measure  Masks Math  Utlities

T " o ]
I

Pormiruspyusinipe Pyl

File Tests Resulls Utilities Help TDSHT3

Source -» Multiple Tests

View Waveform

Waveform should fook like the signal ) as shown. Click Mbre for details.| More

Clock-» Ch1; Data-» Ch2; Rec Length -» 8h; CRU -» PLL; High -= 20%; Low -= 20%

Help

| x|

Result

Summary

=

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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To ensure accurate results, deskew the
probes before you run a test.

8. Click Connect.
9. Click Deskew.
10. Set the parameters as follows:

= Select Internal source for this
example.

m  Verify that the From channel is set
to Ch1 (reference point).

®  Verify that the To channel is set to
Ch2 (channel to be deskewed).

11. Click Run Test to deskew the probes.

12. When deskew completes, click Run
Test to run the test.

13. When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 12.

14. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 14.

15. After you test the Data0 input pair,
move the probe from Data0 to Data1
and repeat the test. Repeat for Data2.

16. Configure the EDID Emulator for the
next pixel clock rate (VGA, SVGA, and
so on), and test for all three data input
pairs. Only one video format is re-
quired per pixel clock rate.

17. Repeat step 16 for all supported pixel
clock rates.

20

File Tests Results UUilites Help

Select Follow these instructions to set up the connections.

Source -= Multiple Tests

File Tests Results Ulilities Help

Source
Select

Wiaw
' aveform

Utilities - Deshen

File Tests Results Utilities] Help

Result Summary| Source

Clock-> Chi; Data-= Ch2; Rec Length -> 18; CRU -> PLL; High -» 20%; Low -> 20%

Click Run Test to Deskew the probes.

TDSHT3 m x|
Run
Test

Report—|

Connect

Deskew
From Input Setup

Hysteresis %
«

n

Ref Level

#of Slopes

Report —
To Input Setup

Summary
Hysteresis %
{3

Ref Level

Report Configuration

Select me Pair {CK, D} Datad
P T ’
m

L A7-5: Undershoot 5]

Resolution

b 475 Overshoot Wi Ci
Configure
[ |76: Undershoot Ui+: Ck

[ 1\[7.5: Overshoot Wi D

Refresh Rate

A7 .
Connect | BIEF-5: Undesho ot vie:

Report—

[A|7-4: FallTime: CK

Report File

L7 FallTime: D
Wieuy
it aveform

Source -= Multiple Tests

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Source: Inter-Pair Skew (Data-Data Tests)

This test verifies that the skew between the differential pairs in the TMDS portion of the HDMI link is within the limits
stated in the HDMI Specifications.

Required equipment Example

2 differential probes; Ground lead Tektronix P7330 or later; Tektronix 196-3469-00
1 DC power supply, setto 3.3V Kenwood PW18-1.8AQ

1 EDID emulator Silicon Image TE9100

1 input adapter Tektronix TPA-P-DI

1. Click Select. @ @
2.

Click the Source tab. File Tests Results filities Help TDSHT3 || x|

3. Select Inter-Pair Skew. seleot

Clock-Data Tests

e |
Configure

Wiem
i 3w eform

Source -* Inter-Pair Skeww D) Data A-* Ch1; Data B - Ch2; Clock - Ch1; Thit: Recalc: Avgs-= 100

4. Click Configure. Change these values File Tests ReguUtiities Help osus | B x|
I Configure - Source
If needed' (YOU can genera"y use the 0 Horizicq Reference Levels Run
ales ;
default Values.) Data & #of Aegs ® Units High g Test
Chi W L Per (%) ¥
Data B Hysteresis & i
Chz - Thit = 10% (3 Report—|
" # of Avgs <L
R
Clock 100 L3 Summary
th ¥
Wiem Existing i
Source -+ Inter-Pair Skew(D.D)  Data A-» Chi; Data B-> Ch2; Clogk-» Chi; Thit Recalo; Avas-» 100
5. Click Connect. Connect

Follow these instructions to set up the connections.
e

Report—

Cannect the
Summary

View oo
ifavatorm o

Source -* Inter-Pair Skeww D) Data A-* Ch1; Data B - Ch2; Clock - Ch1; Thit: Recalc: Avgs-= 100

TDSHT3 HDMI Compliance Test Software Quick Start User Manual 21



Application Examples

22

6. Connect and configure the equipment:

= Connect the test equipment as
shown in the setup diagram.

= Configure the source DUT to
output a video format with the
highest supported pixel clock
frequency.

= Configure the EDID Emulator for
the required resolution (refer to the
EDID Emulator user manual).

7. Click View Waveform.

Verify that the oscilloscope displays a
similar waveform to the one displayed
by the TDSHT3 software. If the
displays are not similar, check your
configuration and connections.

Digital Oscilloscope

EDID Emulator

Select Wavefotrt should ook Iike the signal) as shown. Glick More for details, | More _':u:‘
-
12 ., N Py o

®,
* DATA? ||

TPA-P-DI

File  Edit  Wertical Hotizfacqg  Trig  Display  Cursors  Measure  Masks Math  Utliies  Help

= x|

View Waveform

Result

Summary

Detai

Source -> InterPair SkevaD D) Data A-= Ch1; Data B -» Ch2; Thit: 1.3503ns

TDSHT3 HDMI Compliance Test Software Quick Start User Manual
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Recalculate the Thit value:
8. Click Configure again.

9. Check that the software is set (default)
to recalculate the Thbit value.

10. If your signal has too much jitter and
noise, increase the value in this box
(default = 100).

11. Click Run Test and then click Contin-
ue to run the test with the new Tbit
value.

12. When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 12.

13. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 14.

e Tests Results Utilities Help

Configure - Source

Input Horizifcq Reference Levels

Select High
Data A #of Acgs L/ g
Chi =

{3
Data B
Chz Thit Report—|
#of Avgsff * <L
Connest e
- Clock calculate 100 *

chi W
Wiem Existing .
-\ﬂl'avafurm -\;a‘ue 1 Detail

Source -* Inter-Pair Skeww D) Data A-* Ch1; Data B - Ch2; Clock - Ch1; Thit: Recalc: Avgs-= 100

(12

File Tests Results Utiliths Help TDSHT3

Report Configuration

Select | . . f Datad 1 Run |
st Name 4 b stall !
= = Pair (CK,D) | A i
Led7-6: interPair Skew: D, &
i Resolution 18 i T i
Configure Result
.. Refresh Rate e S
Connect
-. Report File CATek#pplic
wiew | ;
| tiiavefarm : @ Enabie ; Sy Detail

Source -* Inter-Pair SkewaD.D)  Data A-= Ch1: Data B-= Ch2: Clock-> Ch1: Th ecale; Avgs -x 100
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Sink: Min-Diff Sensitivity Test

This test verifies that the sink device properly supports TMDS differential voltages at minimum levels.

24

Required equipment

Example

Digital Timing Generator

Tektronix DTG 5274 with DTM30 output module

8 SMA cables

Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters

1 DC power supply, set to 5.0 V

Kenwood PW18-1.8AQ

1 input adapter Tektronix TPA-R-TDR
1. Click Select.
2. Click the Sink tab.

3. Select Min-Diff Sensitivity.

4. Click Configure. Change these values
if needed. (You can generally use the
default values.)

5. Click Connect.

File Tests Results Utiliies Help TDSHT3 m x|

—Select - Sink

Cable Run
Select

Differential Tests Single-Ended Tests Test

h sitivity e -\nlrs-F'sir "
Configure Result
Report—|
View
i aweform
Sink -2 Min-Ditf 5ensitivity

File Tests Results Utiliies Help TDSHT3 m x|

Configure - Sink

Salest Input Viem
== Outputs

-
chi W Clock Datall

3.0V
Pattern Path o
Configure il
? CATeképplications
Data2
View o
awefarm

Sink -2 Min-Ditf 5ensitivity

Input-= Ch1: Wiem -» 3.0

Input-= Ch1: Wiem -» 3.0

File Tests Results Utiliies Help TDSHT3 El xl
e 2 Commect
Follow these instructions to set up the connections.

,,

1

1 the DUT, tes

oan d test =3
Wiew al cli
Wiaveform

Sink -2 Min-Ditf 5ensitivity

Input-= Ch1: Wiem -» 3.0
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6. Connect and configure the equipment:

10.

= Connect the test equipment as
shown in the diagram.

m  Connect the DTG and oscilloscope
according to the Enable Remote
Control of Test Equipment
procedure on pages 32 through 35.

Click Run Test.

Follow the series of on-screen mes-
sages.

When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 12.

To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 14.

DTG5274

D]

: ‘

C)C) (@) @
C)C)C)

~— ooooo,
[erieleleler)
ODOoOOoOoo
[elesisls)
OOoOoOo!l O

Power Supply

—

N)
y

h_
g
F
g
Foo

©

Sink -= Min-Ditf 5ensitivity

Input-= Chi; Viem -= 3.0%

|| ' Pair (CK, D)

Sink DUT

Report Cnnfguratlnn

Datad
Resolution
Refresh Rate

Report File Fuiany

[l Enable Frewiew

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according
fo the procedure on page 34.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual

25



Application Examples

Sink: Jitter Tolerance Test

This test verifies that your device supports the maximum allowed TMDS clock jitter.

Required equipment

Example

Digital Timing Generator

Tektronix DTG 5274 with DTM30 output module

Arbitrary Waveform Generator

Tektronix AWG710 or AWG710B

12 SMA cables

Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters

1 cable emulator

JAE DC1P19ST02700AA for 27 MHz tests
JAE DC1P19ST07425AA for 74.25 MHz tests

2 bias tees

Mini-circuits ZFBT-4R2GW

1 DC power supply, setto 5V

Kenwood PW18-1.8AQ

2 input adapters

Tektronix TPA-R-TDR
Tektronix TPA-R-DI

1. Click Select.
2. Click the Sink tab.

3. Select Jitter Tolerance.

4. Click Configure. Change these values
if needed. (You can generally use the
default values.)

5. Click the DTG tab and configure which
DTG outputs will provide the clock and
data input signals.

26

TDSHT3 || x|

Single-Ended Tests

File “TMests Results Utiliies Help :

elect

Intra-F air Skewy

i urce
Configure
Report—|
View X
ifaveform o

Sink -= Jitter Tolerance

File Tests Re: Utilities  Help
Select At [ setup I DTG

Clock HoriziAcq Ref Level Units High Ref

Cht W Ret Length " - L]
i >er (%)
Contigure Data o Result

Chz W Hystere: L Mid Ref Report—

- (3 - (3
10% 50%
b Cles :
Low Ref
Wien CRU DUT FrealMHz) &
i aweform PLL ¥ 7425 w

Clogk-* Ch1; Data -* Ch2: Rec Length -* 1h; CRU -> PLL; Freq Pair-* D, Ck:500KHz, 10MHz

Clogk-* Ch1; Data -* Ch2: Rec Length -* 1h; CRU -> PLL; Freq Pair-* D, Ck:500KHz, 10MHz

TDSHT3 || x|

un
Test

Detail

Sink -= Jitter Tolerance

File Tests Results Utiliies Help

onfigure - Sink

@ TDSHT3 || x|

un
Test
DTG

Ch1
Canfi Result
ertiqurs Data

Pattern Path

Bl ¥ Report—|
CiATekpplications

-

Sink -= Jitter Tolerance Clogk-* Ch1; Data -* Ch2: Rec Length -* 1h; CRU -> PLL; Freq Pair-* D, Ck:500KHz, 10MHz
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6. Click Connect.

File Tests Results Utiliies Help

TDSHT3 || x|
Connect

to set up the connections. Run
’— Test
Result

Summary

Sink -= Jitter Tolerance Clogk-* Ch1; Data -* Ch2: Rec Length -* 1h; CRU -> PLL; Freq Pair-* D, Ck:500KHz, 10MHz

7. Connect and configure the equipment:

= Connect the test equipment as
shown in the setup diagram.
= When connecting the test fixture to
the DUT, use a cable emulator 5
specified for the pixel clock rate ‘ ? ?
being tested. DTG CH1 M2
m  Connect the DTG, AWG, and ( | Sos M_1, CH1 | M
oscilloscope according to the s D 5o
Enable Remote Control of Test = cesee -
Equipment procedure on pages 32 o |Soo 88‘ =
through 35. -
S ©
= Configure the DUT to receive the l B i Pl ‘ M2
HDMI input signal. = CH
( @as Tee
—
/ CH1

Power Supply

© e |® o)
EJ Sink DUT

== =]

Cable Emulator
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8. Click Run Test.

9. Follow the series of on-screen mes-
sages.

10. When the test completes, check the
test results. For more information, see
Interpret the Test Result on page 12.

11. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 14.

File Tests Results Utilities Helg TDSHT3 o x|

Report Configuration

Pair {CK, Dy Datad

Resolution 1 1080i

Configure

Report File C
View - | |
Wavetorm & Enable P |

Refresh Rate R port—,

Summary

Sink - Jitter Tolerance Clock -+ Chi; Data -= Ch2: Rec Length -= 1k U-= PLL: Freq Pair-= D, C|

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according

fo the procedure on page 34.

TDSHT3 HDMI Compliance Test Software Quick Start User Manual



Application Examples

Cable: Eye Diagram Test

This test verifies that the cable assembly outputs a compliant data eye.

Required equipment

Example

Digital Timing Generator

Tektronix DTG 5274 with DTM30 output module

2 differential probes; Ground lead

Tektronix P7330 or later; Tektronix 196-3469-00

8 SMA cables

Tektronix 174-1341-00 1 meter or
Tektronix 174-1428-00 1.5 meters

1 DC power supply, set t0 3.3V

Kenwood PW18-1.8AQ

2 input adapters

Tektronix TPA-P-DI
Tektronix TPA-R-DI
Tektronix TPA-P-TDR

1. Click Select.
2. Click the Cable tab.

3. Click Configure. Change the values if

needed. (You can generally use the de-

fault values.)

= Test Points. For the first cable that
you test, select TP1 and TP2 to
verify both the input test signal
(TP1) and the output of the cable
(TP2). For successive cable tests,
clear TP1.

= CRU. Ensure that PLL (default) is
selected for compliance testing.

4. Click the DTG tab. Configure which
DTG outputs will provide the clock and
data test signals.

File Tests Results Utilities Help

TDSHT3 || x|

Source

Differential Tests

e cisom
Configure

Cable - Eye Diagram Clock-» Chi; Data-* Ch2; Rec Length -* 1M, CRU -> PLL; TP4 - true; TP2 - true

TDSHT3 || x|

Configure - Cable

File Tests Utllmes Help
el “p [ Eetup | BTG

nnnnn

Wiew
W awetorm

Cable -= Eye Diagram

HoriziAcq
Rec Length

LTI 4

Test Points

TP1 TP2

CRU
FLL ¥

Ref Level Units

Clock-» Chi; Data-» ChZ; Rec Length -» 1M; CRU -= PLL; TF1 -= true; TFZ -= true

High Ref

Mid Ref

Low Ref

File Tests Results Utilities Help

TDSHT3 m x|
aalont Run
elec Test
o“tp“'s
anfigure 25U
Clock ats
Pattern Path Datal
Al W Bl ¥ Report—,

ohe AT ationdffiE
Datal Data2 Summarny
B2 v oo

Cable -» Eye Diagram

onfigure - Cable

Clock-> Ch1; Data-» ChZ; Rec Length -= 10; CRU -2 PLL; TP .= true; TPZ2 -> true
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5. Click Connect.

6. Connect and configure the equipment
to verify the test signal input:

= Connect the test equipment as
shown in the TP1 setup diagram.

m  Connect the DTG and oscilloscope
according to the Enable Remote
Control of Test Equipment
procedure on pages 32 through 35.

File Tests Results Ultiliies Help TDSHT3
Connect

Select 4 these instructions to set up the connections. Run
Test
Configure Result

Wi et
W/ auefarm

Cable-» Eye Diagram Clock -» Ch1; Data -» ChZ; Rec Length -» 1h; CRU .> PLL; TP -> true; TPZ - > true

Digital Oscilloscope

Power Supply

oo

elelelele)]
© |locoocool|]
e felatate)
alelatalal =]
oOoOoOol O

S !mumm\!mu\

NOTE. When you run sink or cable tests, a warning about GPIB Bus Timing appears. If you are sure that the bus timing
parameter is set to 2 usec, click OK to continue. Otherwise, click Cancel and change the bus timing parameter according

fo the procedure on page 34.
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7. Click Run Test.

8. Follow the series of on-screen mes-
sages.

9. When the test completes, check the
test results. These results confirm that
the test signal input is compliant. For
more information, see Interpret the
Test Result on page 12.

10. Remove the TPA-P-DI adapter and add
the TPA-R-DI adapter as shown in the
diagram.

11. Add the cable DUT between the
TPA-R-TDR and TPA-R-DI adapters.

12. Click Run Test.

13. When the test completes, check the
test results. Pass indicates HDMI com-
pliance of the cable DUT. For more in-
formation, see Interpret the Test Result
on page 12.

14. Click Configure and set the test point

to TP2.

15. Replace the cable with another cable
DUT and click Run Test.

16. To generate reports based on the tests
that you ran, see Generate and Print a
Report on page 14.

File Tests Results Utilities Help

Result Summary: Cable

Pair (CK, D)

[
Cable -* Eye Diagram

Digital Oscilloscope

oooooo

[elNe}

O oo
o] [© 9 Em
o

0 © mooo

o onl

o

Report Configuration

@

TDSHT3 4|

Run |
L Test

Result |

Summary

| Data0 -

Lretail

li——|

Clock-* Ch1; Data-* Ch2: Rec Length -* 1M; CRU -* PLL; TP1 -* true; TP2 -> true

TPA-R-TDR

DTG

[———
colo_[O @
oco|pbog

o d oo

[elelelele)
0

—
o

[elelelee)
OO OO
[elelelee)

[l

000

> mummumu\@

Y
D,

CLOCK P _
= ' Al

Power Supply
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Enable Remote Control of Test Equipment

If you are using the specified Tektronix DTG and AWG models, the TDSHT3 software can configure the connected test
equipment automatically as you run tests. If you are using another DTG or AWG, you must configure the test equipment

manually.

Use this procedure to:

m  Connect the AWG and DTG for remote control

= Configure the GPIB address for remote control

You will need:

m  Tektronix DTG5274, Tektronix AWG710

m  Tektronix 7000 series digital oscilloscope

= National Instruments GPIB-USB-B with the included software, NI-488.2 for Windows

Install NI- 488.2 for Windows

NOTE. If you already have NI-488.2 installed on your oscilloscope, ensure that you have the version and installation
parameters that are described in step 1. If you do not, then uninstall NI-488.2, and install it according to step 1.

1. Install NI-488.2 for Windows (ver-

sion 2.1 or later).
During installation:

2. Do not install NI-VISA.

3. Install the Measurement & Automation

Explorer.

4. When prompted, enable the GPIB-

USB interface.

5. Restart the oscilloscope.

32

O

®

=NI-488.2 for Windows

@:

Feature Tree
Selectthe features to be installed

i,

o =i

NI-488.2°

High Performance GPIB Software

=53+ NH88.2
= +| Driver and Applications
- _i‘ GFIB Analyzer
£ £ -] Language Support
o 53 =] Microsoft GG+
Borland C/C++
o 59 = Visual Basic
L3 | LabvIEW
o 53 +| LabWindows/CYI
) L= Other
03 - NFVISA 2B
103 -| Measurement & Automation Explarer

Target Directory

Browse |

Feature Description

Disk Cost |

<< Back Mext>> | i Cancel I
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Connect the Equipment

6. Connect the USB-GPIB controller to
the oscilloscope USB port. The oscillo-
scope operating system detects the
USB-GPIB controller and installs the
driver for it.

7. Using GPIB cables, connect (stack) the
DTG and AWG GPIB connectors to the
GPIB port of the GPIB controller.

If your test does not use the AWG,
connect the GPIB-USB-B between the
oscilloscope and the DTG, omitting the
stacked connector from the AWG.

Verify the Equipment Connections

8. Open the Measurement & Automation
Explorer that was installed with the
NI-488.2 software.

9. In the Configuration pane, under De-
vices and Interfaces, right-click the
GPIB device.

10. Click Scan for Instruments.

11. Note the GPIB Instrument Number and
the Primary Address.

12. Right-click the instrument and click
Communicate with Instrument.

13. Click Query and check that *IDN? de-
scribes the correct equipment.

©

. USB
GPIB Oscilloscope
= = 0] o Io]
AWG L e b
’ @ S o —— |9
o ¥ =p BAAEEHAEE
=3
°6 ] oD %L J
@ 0004qo
[ ) ] 7 (w—
GPIB (Stacked
@
connectors)
0 — =
——= 7 &
- - GPIB-USB-B
e
®® 00 e J/
® ®
T I
4] )
lomation E:@ =10x|

File Edit Wiew Tools @ Help

Configuration

E&'Properties ‘ B3, 5can For Instrumen s | 3 N SPY\_/é Analyzer

EET/A

< Show/Hide

=% My System

‘£ GPIEN (GPIB-USE-B)
Software

Iame

I Wa\ e

| Description

B!} GPIE Interf/ace Mumber 0
[g] Instrumentd

Primary Address ...

TEKTRONIX,DTGS274, 1300167
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- @ Remote Systems Instrument1 Primary Address .., SONY/TEK,AWG710,0,5CP1:99
| | 0
- I2] | mm evites |
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Set the GPIB Bus Timing

14. Right-click the GPIB device and click (E Measwement & AutcsIH N ; 5
Properties. Fle Edit wiew Iools Help

J E&'Properties ‘ l;.kScanFannstr’umenl:s | W MISpy L, GPIB Analyzer

Configuration

r=/|GPIBO (GPIB-USB-B)

-2 My System

- Mame I Walue | Description
= Cevices and Interfates | | gy o 1o foce fiumber 0
é Si;ﬂizio HERER L Instrumentd Primary Address ... TEKTRONIX,DTGS274, 1300167
= @ Remote Systems Instrument1 Primary Address ...  SONY/TEK,AWS710,0,5CP1:99
4] | 1|
K1 |21 o Atibutes
4
15. Click the Advanced tab. 49 GP1B Configuration 2] x|
16. In the Bus Timing list, select 2usec. NI48B.2 Setings Achvancad |

7 - =
17. Click OK. (Be sure that you complete VAR

the procedure through step 28, where
you will exit the software and restart

Bus Timing ISDDnsec vl
the oscilloscope.)

Farallel Foll Duration: S00nsec

Cahle Length for HS 488 Off b

v Automatic Serial Folling

[~ Assed BEM when SC

|— Ok | Cancel

Configure the GPIB Address

18. Start the TDSHT3 software. File Tests Results Utilities Help HDMI Utility v0.6.3 | S| X

19. Click Select.

[
20. Click the Sink tab. L

Single-Ended Tests

21. Select a Differential test, such as Jitter
Tolerance. Detai

Sink -= Jitter Tolerance Clogk-* Ch1; Data-» Ch2: Res Length -= 16M: CRU-Clock-> PLL:
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22. Click Connect. File Tests Results Utiities Help HDMI Utility v0.6.3 | BEh| >

Connect

23. Click signal Sources. Follow these instructions to connect your setup.

.

Sink -= Jitter Tolerance Clogk-* Ch1; Data-» Ch2: Res Length -= 16M: CRU-Clock-> PLL:

For the Tektronix DTG5274 generator:

24. Click the DTG tab.

25. Click GPIB. Select GPIE setup

26. Click the AWG tab and repeat. Board Type Address
ZPIBO0 W Primany

27. Click Test Conn and look for a mes- D -

sage that the connection is successful.
28. Exit the TDSHT3 software and restart Secondary

the oscilloscope. @ o w
-
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Index
A

Acquisition, 7

Address, Tektronix, iv
Advanced, 15

APP button, 8
Application examples, 18

Cable tests, Eye Diagram, 29

Sink tests
Jitter Tolerance, 26
Min-Diff Sensitivity, 24
Source tests
Inter-Pair Skew, 21
Select All, 18
AWG setup, 32

Buttons, 5

C

Cable, Eye Diagram test, 29
Cable emulator, 27

Calibrate probes, 3

Clear report, 15

Client pane, 5

Close the application, 4
Configure, 10

Configure button, 9
Configure test equipment, 32
Configure the GPIB address, 34
Connect, 10

Connect button, 9

Connect test equipment, 32
Connections, 1

Contact Tektronix, iv
CSVfile, 14

D

Deskew, 20

Detail, 17

Detailed report, 15
Device under test type, 5
Documentation, iii

DTG setup, 32
DTG5274, 35

DUT Details, 16

DUTID, 16

DUT type, 5
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E

Edge trigger, 7

EDID emulator, 20
Enable Preview, 15, 17
Error codes, 12
Execution pane, 5

Exit button, 4

Exit the software, 4

F

Factory defaults, 10
File
Exit, 4
Preferences, 7
Run application, 2
Fine button, 7

G

General purpose knob, 7, 10
Generate areport, 14

Generator setup, 32

Get acquainted with the application, 5
GPIB, 35

GPIB address, 34

GPIB bus timing, 34

H

Half Screen, 13
HDMI standards conformance, iii
Hide icon, 8
Hide the application, 8
How to
Install your software, 1
Make tests, 9
Operate the Application, 9

Installation, 1

Inter-Pair Skew test, 21
Interface, 5

Intersymbol interference, 7

J

Jitter Tolerance test, 26

K

Key features, iii
Keyboard, 5
Knob, 7, 10

Make tests, 9

Menu bar, 5

Menus, 5

Min-Diff Sensitivity test, 24
Mouse, 5

Multiple tests, 9

NI-488.2 for Windows, 32

0)

Oscilloscope general purpose knob, 10

P

Pair, 15

Pixel clock rates, 20

Position eye mask in center, 7
Preferences, 7

Print a report, 14

Product description, iii
Product support, iv

R

Recalculate Thit value, 23
Refresh Rate, 15

Related documentation, iii
Remote control, 32
Report File, 15

Report file formats, 14
Report summary, 14
Resolution, 15

Restore application, 8
Result Details, 12
Results, 12

Results button, 9

Return to the application, 8
RGT format, 14

RPL format, 14
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RPT format, 14
RTF format, 14
Run Test, 11

Run Test button, 9

S

Select button, 9

Select All, 9, 18

Select multiple tests, 9

Selection pane, 5

Service support, contact information, iv

Set preferences, 7

Signal Sources, 35

Sink, Differential
Jitter Tolerance test, 26
Min-Diff Sensitivity test, 24

Software upgrades, iv

Source, Data-Data, Inter-Pair Skew
test, 21

Source tab, 9

Source tests, Select All, 18

Start the application, 2

Status bar, 5

SVGA, 20

T

Thit value, 23

Technical support, iv

Tektronix, contact, iv

TekVisa, 1

Test Conn, 35

Test equipment, 32, 33
Connect, 10
Setups, 1

TestID, 9

Test ID 5-3, 29

Test ID 8-5, 24

Test ID 8-7, 26

Test parameters, Configure, 10

Test results, 12

Tests, Process flow, 9

Touch screen, 5

TPA-P-DI, 1

TPA-P-SE, 1

TPA-R-DI, 1
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TPA-R-SE, 1
TPA-R-TDR, 1
Trigger, 7

U

Use oscilloscope settings for image
export, 16
Use the interface, 5

vV

VGA, 20

View test results, 12
View Waveform, 11

View Waveform button, 9
Virtual keyboard, 5, 10
Virtual keypad, 6

w

Web site address, Tektronix, iv
Width trigger, 7
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